
Remote Sensing, Fall 2024 

Lab 5:  Feature Extraction 
 

Lab goals  

Satellite images like air photos can be used for manual interpretation, but because they are 

digital, we can use image processing techniques to semi-automatically extract vector features. 

The specific goal in this week's lab is to create vectors for 2-3 class features which you can 

clearly identify and reduce to a manageable number of polygons.  

There are five main steps: 

• Generate a clean layer containing the desired features –a bitmap or raster channel from 

THR or Ratio-Index-Transform or Classification 

• SIEVE to create a manageable number (sieve works only on raster channels) 

• Generate vectors (raster to vector) –RAS2POLY or  BIT2POLY or EXPOLRAS 

• Smooth vectors – SMBOYLE or SMMCMASTER 

• Examine and clean attribute table  - calculate area stats (in Catalyst or GIS) 

Features to extract:  

• 1. Water   

• 2. A deciduous land cover class 

 

1. Bitmap layer prep – Extract water from the 2023 multispectral image 

I’ll come in the lab early to be sure this is not confusing! 
 

For water, you already have an “almost ready to go” water layer from lab 2 created by 

thresholding NIR band or unsupervised classification, but they included those pesky shadows 

(which are even more severe in mountain environments).  

 

In lab 3, you created a better water class using supervised classification, and in lab 4, the 

NIR/Red ratio with threshold 1.0 seemed to create a clean water layer, though I didn’t require 

you to save it (sorry!). [If you did, you already have your bitmap and can skip down to the next 

section.]   Both labs 3-4 used the superior PG-July2023 file with no clouds and higher sun.  

 

2. Start Catalyst and Load/open the PG 2023 image ..  

 

To get to what you need, you would either display the ratio channel (layer-add-> grayscale-> 

ratio channel and run THR (1.0 Maximum) to recreate the water bitmap for 2023, or load your 

classification channel (layer->add->pseudocolour-> pick your classification  

… check which class is water (likely to be ‘1’) and then run THR on this channel with both 

minimum and maximum set to 1. This will isolate just the water class and convert to a bitmap. 

You could do both if curious. Be sure to save this bitmap to your copy of the PG2023 file 

Check the water bitmap number – switch to files tab and expand ‘bitmaps’ -likely it may be ‘2’ 



3. Vectorise the bitmap to create water outlines: BITPOLY 

 
tools-> algorithm library → BIT2POLY 
Input: the bitmap layer number (2 ? ) 
Output: viewer  
Params: smooth should be checked        RUN 
 

If you can’t see your new vector lines e.g. if they are blue, you can right-click on the new 

polygon layer in the display listing and change the colour 
 

Now uncheck the smooth vectors box in parameters and run again, output to the viewer, AND 

save to your pix file.  Compare the result with the smoothed version to see the effect of the 

smoothing algorithm … 
Zoom in A LOT to view the difference – the ‘staircase’ of pixels has been reduced, not removed 

 
You now have two vector layers, one smoothed (onscreen only), one saved but not smoothed. 

 

We will use a more sophisticated algorithm to smooth the unsmoothed version, written by Ray 

Boyle, U. Saskatchewan. It is called SMBOYLE and is found in the Algorithm Library. 

 

Input your unsmoothed vector layer, output to viewer and the 2023 pix file. 
This should be a better result - NOT smoothed in BIT2POLY but smoothed by SMBOYLE.  The 

one smoothed only in BIT2POLY is not as rounded. 

 

 

4. polygon attribute tables 
 

You can’t sieve a bitmap to remove wee bits, only a raster, but we can remove small polygons 

either in GIS or Catalyst:  right-click on the new polygon layer label -> pick Attribute Manager 

The areas may be in square metres as default with UTM coordinates, and if so we can convert to 

hectares or square kilometres to reduce ‘scientific notation’- we will select hectares  
 

Right-click on the Area column heading, select Table definition, change decimal places to 2 and 

display units to Hectares.      Apply     OK 

Deselect Area heading – click on it 

 

Now we can remove small polygons the ‘GIS way’. 

Select the Record dropdown, then query by -> example 

We will choose to remove lakes smaller than one acre (~0.5 hectares) 



Edit the statement to read:  Area < 0.5             

You MUST edit using the menu provided, not your keyboard –  

Use the operator button and click on ‘entire list’ to display all values 

Click on Insert         Apply        OK 

 

Now all records are gray highlighted if Area < 0.5 hectares 

Right-click on one that is selected in the left column and pick delete – deletes all the small ones 

You have deleted all the wee polygons smaller than .5 hectares  

 

Layer-> Save as  ->       pick your 2023 pix file and the Polygon Layer 

 

Layer-save as again and this time scan down a few lines to the ArcGIS shapefile, and save as 

shapefile .. you could name it something like water2023.shp and save in your folder. This can be 

directly opened in ArcGIS or QGIS – unlike the layer stored in the .pix file (in PCI format). 

 

In the attribute table you should see the polygons listed in order of area and by clicking in the left 

column, it will highlight that feature. The top 3 should be the Nechako/Fraser (one polygon) and 

Tabor and Swampy Lakes .. the rest get harder to see due to size. Ferguson Lake should be #4. 

 

Click in the top left column (blank to the left of 'ShapeID', and you should see a summary of 

stats for the water polygons, including total area (sum) for the polygons.  

 

Q1: What is the area of each of the two largest lakes (hectares) – which lake is larger ? 

Q2. how many water bodies are in this layer now and what is their total area (km2) 

  

 

5. Polygon layer for a vegetation land cover class – Bowron Lakes 
 

Done with PG for now, and maybe all the labs !  We will start a new project – 2 options 

File -> New project   (discard old one) OR  if you think you may just want to return before end 

of lab, either save or just open a 2nd Focus window from the Catalyst panel (leftmost option).   

 

Copy bowron19aug2016.pix   from  L:\GEOG357  and also bowron19aug2016pan.pix 

In Focus open your copies of bowron19aug2016.pix   and the PAN file   

Display the standard bands 654 in RGB  - the PAN will open in grayscale 



 
        Check what the bands are by switching to the files tab, and expanding rasters – this is Landsat 8 

Sxwitch back to Maps tab. Zoom in to see the finer details of the PAN layer, especially around 

the (bright yellow in 654) avalanche slopes which is what we will try to extract. 

        We’ll extract as best we can these deciduous slopes that show as yellow strips caused by snow 

avalanches in the winter/spring months, ripping out the coniferous trees to be replaced by 

deciduous shrubs (much loved by grizzlies for food). 

To extract them – if we had lots of time – we might first do a supervised classification (in a 

project), but for this lab we can generate NDVI and assume they will have the highest DN 

values. They will also include adjacent alpine meadows mostly above the avalanche slopes, 

though the results are unlikely to be perfect – that’s inevitable. 

 

Use the Raster calculator to create  NDVI: (%5-%4) / (%5+%4) .. (SWIR1 and NIR) 

Remember to write this to a 32-bit channel and as a new layer in your Bowron 2016 pix file. 

Review the histogram for NDVI – DN values should range from negative (water) to maximum 

for deciduous (~0.6 ?). Query the DNs in this layer on the avalanche slopes –I found a minimum 

value between 0.35 and 0.40 was good - confirm for yourself as I can make mistakes, yes really ! 

  … we won’t need to state a maximum as we assume these are the highest values. The best way 

to query is to have the colour composite displayed, but the NDVI layer highlighted. You should 

be able to read the NDVI values and clearly see what are avalanche slopes. Sometimes you have 

to click in the table of contents anywhere and then click again on the NDVI layer. 

 

EXPOLRAS:  This algorithm tool goes beyond BIT2POLY with multiple steps to extract and 

refine features by thresholding, sieving and vectorizing all in one operation. 
 
Tools → Algorithm Librarian -> EXPOLRAS 
Input: your NDVI  channel 
Output: to viewer and your 2016 pix file 
 
Params: 
Threshold Minimum  0.xx (I found 0.38 to be OK) 
Minimum Area:  12 – this is the sieve operation (1 hectare or greater) 

Compactness could be interesting given the general shape of our feature, but we’ll leave it as is 

Go to log tab and Run … it should be successful          but check 



You now have a polygon layer for avalanche slopes– you don’t need to remove small polygons 

as the minimum did this, though you may still find some small ‘donut holes’ of non-

deciduous in the avalanche slopes etc..  However the high values will also catch many of 

the regenerating cutblocks. We can use the Bowron Lakes park boundary polygon to 

remove these with a ‘clip’ as there are no cutblocks inside the park – it is a park ! 
 

Smoothing – run SMBOYLE - output to Viewer and save to your .pix file 

 

Q3a: how many smoothing routines are in the Algorithm Library ? (all begin with ‘SM’) 

b. Which one does Catalyst recommend for converted raster data and why  

Note that I am biased as Ray Boyle is Canadian and I met him at U.Sask        

 
Right-click on the polygon label in the 'maps' tab and open the Attribute manager.  
convert units to square hectares, and review the total. Save the polygons as a layer in the pix file 

and also save the vector segment also to a shapefile (e.g. avslope.shp) 
 
Add the Bowron Lakes Park boundary shapefile: 

Layer-> add-> vector and browse to L:/GEOG357/shapefiles/bowron-utm.shp 
[remember to do the final click on the VEC link in the bottom window] 
Now loaded, right-click ->save as -> (format) Arcview shapefile … in your own folder as I think 

you may need this copy to successfully do a clip (?) 
 

You can see all cutblocks are neatly outside the Park – of course, it is a park ! 

We should clip our avalanche slopes to just get the ones inside the park (see graphic) 

 
CLIP: Catalyst clips rasters well but not vectors, so you should do this in ArcGIS or QGIS. Are 

you able to do this – let me know if not… (Clip av.slopes with your park outline) 

 
 

 
Q4a: what is the area of avalanche slopes inside the park 

(accepting our image misses some parts of the park in the 

north and southeast). Give the answer in kilometres. 

 

 

 

 

 

 

 

4b. Having removed cutblocks outside the park, briefly describe any remaining ‘problematic’ 

features inside the park with high NDVI that do not seem to be avalanche slopes 



 

 

 

6. Edge-enhancing Filters: FED / FSOBEL / FSHARP 
 

The tools include a number of filters – some for smoothing, others for the opposite. They all 

sample a window of DNs  e.g. 3x3 or 7x7 and perform either averaging or difference result. 

Software such as Photoshop have similar operations  

 

Edge filters may in some cases serve to highlight feature boundaries almost like vectors. 

Find this tool: FED 

Input channel is your NDVI, Output – viewer-grayscale (just to the screen), keep parameter 

defaults (3 x 3) and run.  

Wow!  it seems to nail the water edges, and the avalanche slopes edges are at least visible. 

Check the DN values on edges and within the lakes 

 

 

Now try FSOBEL – same parameters and Run – maybe even better ? for the avalanche slopes ? 

Check the DN values again on edges and inside the lakes 

 

Finally have a look at the effects of filter: FSHARP (no, it’s not music) 

As before, pick your NDVI channel for input, viewer-grayscale, params: default, run 

Set the filter size to 5x5 pixels and view the result again – v. sharp ! 

Hmmm … seems we could sharpen up bands 4,5,6 and create a sharper colour composite – 

almost like pansharpening when you don’t have a separate PAN band (but without the haze)? 

 

 

Q5a: describe briefly how/why do the edge filters pick out water so cleanly 

5b. why does water itself have such low DN values in the FED and FSOBEL results ? 

 

 

Repeat of previous questions: (1-2 from PG 2023 image) 

Q1: What is the area of each of the two largest lakes (hectares) – which lake is larger ? 

Q2. how many water bodies are in this layer now and what is their total area (km2) 

 

Q3a: how many smoothing routines are in the Algorithm Library ? (all begin with ‘SM’) 

b. Which one does Catalyst recommend for converted raster data and why  

 

Q4a: what is the area of avalanche slopes inside the park (accepting our image misses some 

parts of the park in the north and southeast). Give the answer in kilometres. 

 

4b. Having removed cutblocks outside the park, briefly describe any remaining ‘problematic’ 

features inside the park with high NDVI that do not seem to be avalanche slopes 

 


